
Certified according to ISO 9001:2015

LASER WHEEL PROFILOMETER

 

User's manual

IKP-5 Series, Model 2017 Year



2

Laser Wheel Profilometer. IKP-5 Series, Model 2017 Year

IKP-5 Series, Model 2017 Year [Revision 1.1.0] 10.11.2017

Contents

.............................................................................................................................................51.    Safety precautions and measurement conditions

.............................................................................................................................................52.    CE сompliance

.............................................................................................................................................53.    Laser safety

.............................................................................................................................................54.    General information

.............................................................................................................................................65.    Basic technical data

.............................................................................................................................................76.    Example of designation when ordering

.............................................................................................................................................77.    Complete set to be supplied

.............................................................................................................................................88.    Device structure
........................................................................................................................................... 8

 
   8.1.    Basic components of the device and their functions

................................................................................................................. 9
 
      8.1.1.    Digital readout device

................................................................................................................. 10
 
      8.1.2.    Laser scanning module

................................................................................................................. 12
 
      8.1.3.    Calibration block

.............................................................................................................................................129.    Operation principle

.............................................................................................................................................1210.    Geometric parameters of the wheel under control
........................................................................................................................................... 12

 
   10.1.    Flange height, sH

........................................................................................................................................... 13
 
   10.2.    Flange thickness, sD

........................................................................................................................................... 14
 
   10.3.    Flange slope, qR

........................................................................................................................................... 14
 
   10.4.    Wear parameters

........................................................................................................................................... 15
 
   10.5.    Angle parameters

........................................................................................................................................... 16
 
   10.6.    Rim parameters

........................................................................................................................................... 16
 
   10.7.    Wheel diameter

........................................................................................................................................... 16
 
   10.8.    Parameters of tram wheels

........................................................................................................................................... 17
 
   10.9.    Wheel defects

.............................................................................................................................................1711.    Coordinate system

.............................................................................................................................................1812.    First activation and measurement procedure
........................................................................................................................................... 18

 
   12.1.    Activation

........................................................................................................................................... 19
 
   12.2.    Measurement

.............................................................................................................................................2113.    PDA program setting
........................................................................................................................................... 21

 
   13.1.    Measurement type

........................................................................................................................................... 21
 
   13.2.    Units of measurement

........................................................................................................................................... 22
 
   13.3.    Date/time setting

........................................................................................................................................... 22
 
   13.4.    Device selection

........................................................................................................................................... 24
 
   13.5.    Language setting

........................................................................................................................................... 24
 
   13.6.    Synchronization with PC

.............................................................................................................................................2514.    Measurement parameters setting
........................................................................................................................................... 26

 
   14.1.    Calculation methods setting

........................................................................................................................................... 26
 
   14.2.    Selection of displayed parameters

........................................................................................................................................... 26
 
   14.3.    L-parameters setting

........................................................................................................................................... 27
 
   14.4.    Preset parameters values

.............................................................................................................................................2815.    Setting the database parameters, tolerances and measurements schemes
........................................................................................................................................... 28

 
   15.1.    Selection of the current database

........................................................................................................................................... 29
 
   15.2.    Reference profile selection and installation

................................................................................................................. 30
 
      15.2.1.    Writing the reference profile to the database

........................................................................................................................................... 30
 
   15.3.    Selection and formation of the measurement scheme

................................................................................................................. 30
 
      15.3.1.    Selection or removal of the measurement scheme

................................................................................................................. 31
 
      15.3.2.    Formation of a new measurement scheme

................................................................................................................. 31
 
      15.3.3.    Loading of a new measurement scheme

........................................................................................................................................... 31
 
   15.4.    Setting of tolerances

........................................................................................................................................... 32
 
   15.5.    Wheel type selection and installation

.............................................................................................................................................3316.    Updating of PDA software

.............................................................................................................................................3417.    Shutdown

.............................................................................................................................................3418.    Measurements with database maintenance



Laser Wheel Profilometer. IKP-5 Series, Model 2017 Year

IKP-5 Series, Model 2017 Year [Revision 1.1.0] 10.11.2017

3

........................................................................................................................................... 35
 
   18.1.    Measurement

........................................................................................................................................... 37
 
   18.2.    Measurement of even/uneven wear

........................................................................................................................................... 38
 
   18.3.    Measurement of defects

.............................................................................................................................................3919.    Measuring by IKP, IDK, IMR, and saving to database

.............................................................................................................................................3920.    Browsing the database
........................................................................................................................................... 40

 
   20.1.    Data filtering

........................................................................................................................................... 40
 
   20.2.    Visualization of the wheel profile

.............................................................................................................................................4121.    Installation of software on PC and startup
........................................................................................................................................... 41

 
   21.1.    Installation of database support software

........................................................................................................................................... 41
 
   21.2.    Synchronization of PDA and PC

........................................................................................................................................... 42
 
   21.3.    Program startup

.............................................................................................................................................4322.    User settings of the program
........................................................................................................................................... 43

 
   22.1.    Parameters setting

................................................................................................................. 43
 
      22.1.1.    "Wheelset's parameters" tab

................................................................................................................. 44
 
      22.1.2.    "Calculated parameters" tab

................................................................................................................. 44
 
      22.1.3.    "L-parameters" tab

................................................................................................................. 44
 
      22.1.4.    "Measurement method" tab

.............................................................................................................. 45
 
         22.1.4.1.    Selection of measurement units

........................................................................................................................................... 45
 
   22.2.    Database settings

................................................................................................................. 45
 
      22.2.1.    Setting the path to database

................................................................................................................. 46
 
      22.2.2.    Creation of empty database

................................................................................................................. 46
 
      22.2.3.    Import of database  

................................................................................................................. 46
 
      22.2.4.    Selection of software language

.............................................................................................................. 47
 
         22.2.4.1.    Preparation and installation of the language support file

........................................................................................................................................... 47
 
   22.3.    Registration data

................................................................................................................. 47
 
      22.3.1.    Selection of the organization

................................................................................................................. 48
 
      22.3.2.    Registration of operators

................................................................................................................. 48
 
      22.3.3.    Registration of series

................................................................................................................. 49
 
      22.3.4.    Registration of car/locomotive numbers

................................................................................................................. 49
 
      22.3.5.    Registration of tolerances

................................................................................................................. 49
 
      22.3.6.    Registration of reference profiles

.............................................................................................................. 50
 
         22.3.6.1.    Request and registration of the profile file

.............................................................................................................................................5123.    Data exchange between PDA and PC
........................................................................................................................................... 51

 
   23.1.    ActiveSync synchronization

................................................................................................................. 51
 
      23.1.1.    Transfer of database file to PC

................................................................................................................. 52
 
      23.1.2.    Transfer of language file from PC to PDA

................................................................................................................. 53
 
      23.1.3.    Transfer of language file from PDA to PC

................................................................................................................. 53
 
      23.1.4.    Transfer of reference profile files from PC to PDA

................................................................................................................. 54
 
      23.1.5.    Transfer of processing scheme file from PC to PDA

................................................................................................................. 54
 
      23.1.6.    Updating of PDA software

........................................................................................................................................... 55
 
   23.2.    Mass Storage synchronization

.............................................................................................................................................5624.    Working with profilograms and wear calculations
........................................................................................................................................... 56

 
   24.1.    Browsing the graph and profile coordinates

........................................................................................................................................... 57
 
   24.2.    "Parameters" tab

................................................................................................................. 57
 
      24.2.1.    Selecting a profile to compare

................................................................................................................. 57
 
      24.2.2.    Selecting L-parameters values

................................................................................................................. 58
 
      24.2.3.    Geometric parameters of the profile

........................................................................................................................................... 58
 
   24.3.    Wear calculation

................................................................................................................. 58
 
      24.3.1.    Fast wear calculation

................................................................................................................. 59
 
      24.3.2.    Wear calculation at all points

................................................................................................................. 59
 
      24.3.3.    Export to Excel, DXF, REF

........................................................................................................................................... 60
 
   24.4.    Alignment of profiles

........................................................................................................................................... 61
 
   24.5.    Superposition of profiles

........................................................................................................................................... 61
 
   24.6.    Rescaling

.............................................................................................................................................6125.    Implementation of minimum wheel truing function

.............................................................................................................................................6326.    Scanning and editing of data
........................................................................................................................................... 63

 
   26.1.    Scanning and filtering of data



4

Laser Wheel Profilometer. IKP-5 Series, Model 2017 Year

IKP-5 Series, Model 2017 Year [Revision 1.1.0] 10.11.2017

........................................................................................................................................... 64
 
   26.2.    Editing data

........................................................................................................................................... 65
 
   26.3.    Report preparation  

................................................................................................................. 66
 
      26.3.1.    Excel-format report

................................................................................................................. 66
 
      26.3.2.    Report for printout

.............................................................................................................................................6727.    Taking measurements under PC control (without PDA)
........................................................................................................................................... 68

 
   27.1.    Calibration

................................................................................................................. 68
 
      27.1.1.    Bluetooth-connection

................................................................................................................. 69
 
      27.1.2.    Calibration of the profilometer

........................................................................................................................................... 70
 
   27.2.    Measurement by using PC

................................................................................................................. 70
 
      27.2.1.    Saving of data

.............................................................................................................................................7128.    Annex 1. Charging procedure

.............................................................................................................................................7129.    Annex 2. Program for creating the measurement schemes

.............................................................................................................................................7330.    Annex 3. Testing and calibration
........................................................................................................................................... 73

 
   30.1.    Preparation for testing/calibration

........................................................................................................................................... 74
 
   30.2.    Testing

........................................................................................................................................... 76
 
   30.3.    Calibration

........................................................................................................................................... 77
 
   30.4.    Restoring the factory settings

.............................................................................................................................................7831.    Annex 4. Software application for working with the "A.U.R.A. Wheel" system
........................................................................................................................................... 78

 
   31.1.    Installation

........................................................................................................................................... 78
 
   31.2.    Settings

................................................................................................................. 79
 
      31.2.1.    Language

................................................................................................................. 79
 
      31.2.2.    Gauge type selection

................................................................................................................. 82
 
      31.2.3.    Password

................................................................................................................. 83
 
      31.2.4.    Calculation methods

................................................................................................................. 83
 
      31.2.5.    Selection of displayed parameters

................................................................................................................. 84
 
      31.2.6.    L-parameters

.............................................................................................................. 84
 
         31.2.6.1.    Preset values

................................................................................................................. 85
 
      31.2.7.    Reference profile selection and installation

.............................................................................................................. 85
 
         31.2.7.1.    Writing the reference profile to the database

................................................................................................................. 85
 
      31.2.8.    Measurement scheme

.............................................................................................................. 86
 
         31.2.8.1.    Selection or removal of the measurement scheme

.............................................................................................................. 86
 
         31.2.8.2.    Formation of a new measurement scheme

................................................................................................................. 87
 
      31.2.9.    Tolerances

................................................................................................................. 88
 
      31.2.10.    Vehicles

........................................................................................................................................... 88
 
   31.3.    Measurements

................................................................................................................. 89
 
      31.3.1.    Single measurement

................................................................................................................. 90
 
      31.3.2.    Simple measurement

.............................................................................................................. 92
 
         31.3.2.1.    Measurement

.............................................................................................................. 95
 
         31.3.2.2.    Measuring by IDK, IMR

................................................................................................................. 96
 
      31.3.3.    Automated measurement

.............................................................................................................................................9832.    Warranty policy

.............................................................................................................................................9833.    List of changes



IKP-5 Series, Model 2017 Year [Revision 1.1.0] 10.11.2017

Laser Wheel Profilometer. IKP-5 Series, Model 2017 Year

5

1.     Safety precautions and measurement conditions
· Prior to mounting the profilometer onto the wheel, areas of contact of the side

supports with the wheel surface should be thoroughly cleaned from dirt.
· When mounting the module on the wheel, do not allow heavy shocks of its support

against the wheel.
· The output window of the profilometer and profilometer supports must be carefully

inspected and cleaned. 
· Do not use laser module in locations close to powerful light sources.

2.     CE сompliance
The profilometers have been developed for use in industry and meet the

requirements of the following Directives:
· EU directive 2014/30/EU. Electromagnetic compatibility (EMC).
· EU directive 2011/65/EU, “RoHS“ category 9.

3.     Laser safety
The profilometer makes use of an c.w. 660 (or 405) nm wavelength semiconductor

laser. The maximum output power is 1 mW. The device belongs to the 2 laser safety class
according IEC/EN 60825-1:2014. The following warning label is placed on the profilometer
body:

The following safety measures should be taken while operating the profilometer:
· Do not target the laser beam to humans.
· Do not disassemble the sensor.
· Avoid staring into the laser beam.

4.     General information
A laser profilometer IKP5 Series is designed for measuring of
· wheel flange height 
· wheel flange thickness  
· wheel flange slope
· rim thickness
· full profile scanning and analyze of wheel rolling surface
· maintaining of electronic wear data base
· control of tolerances and sorting in the course of checkup, examination, repair and

formation of railway wheel sets. 
Measurements are made directly on rolling stock without wheel set roll-out. 
Profilometers are implemented in three configurations: with the standard handle,

with the shorten handle (Short version) and very short handle (Super short version) . The
version with the shorten handle is intended to measure the wheels with the limited space for
installing the profilometer. The version with very short handle is specially designed to
measure wheels of Ansaldo Breda low floor trams with very limited space for
profilometer installing. This super short profilometer version has separate battery block,
connected by cable with laser module.
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5.     Basic technical data

Name of parameter Value

Measurement range  

Flange height, mm
Flange thickness, mm
Flange slope, mm
Rim thickness, mm
Diameter (calculation method), mm

20…45
20…50
1…15

36…100 (30...90)
400…1400

Measurement error

Flange height, mm
Flange thickness, mm
Flange slope, mm
Rim thickness, mm
Diameter, mm

± 0.03
± 0.03
± 0.1
± 0.1
± 0.1

Discreteness of indication 

All parameters, mm 0.01

Profile measurement range, mm 145

Discreteness of the profile formation, not worse than, mm 0.025 (5800 points for profile)

Digital readout device (PDA) dimensions, mm see Fig. 3

Dimensions of laser scanning module, mm see Fig. 5

Measurement time, s adaptive, depending on surface quality,
4 average

Power supply (laser scanning module) 3.7V
Li-ion rechargeable battery

5400mAh for standard IKP and
2400mAh for Short and Super-short

The number of measurements that can be taken before battery
recharge is not less than

5000 for standard IKP and
2200 for Short and Super-short

Laser module battery life time 5 million measurement cycles

Power supply (PDA) 3.7V
Li-polymer battery

3300mAh

PDA memory capacity 100 000 measurements

Interface between laser scanning module and PDA Bluetooth

Working temperature range, °С -20…+50

Enclosure rating IP42 or IP64
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6.     Example of designation when ordering

IKP-V-М-S-T-R

Symbol Description

V Profilometer version:
without symbol - Standard version
Short - Short handle
SShort - Super short handle
SShort-EB - Super short handle and external battery

M Options of the set of magnets for mounting on the internal/external rim face:
S – standard. Standard magnets (specified by default).
F – forced. Reinforced magnets.

S Options of the support plates embodiment:
D – direct. Standard plates, profilometer is mounted on the internal rim face (specified
by default).
I – invert. Custom plates, profilometer is mounted on the external rim face.

T Presence of the rim measurement rod.

R Enclosure rating:
without symbol - IP42 
64 - IP64

Example: 
IKP-Т  – standard magnets; standard support plates; presence of the rim

measurement rod. 
IKP-F-I – reinforced magnets; custom support plates. 
IKP-Short-T - the shorten handle; presence of the rim measurement rod.

7.     Complete set to be supplied

Designation Name Quantity Weight,
kg

RF303М Digital readout device (PDA) 1 0.3

RF505 Laser scanning module 1 0.8

RF505.40 Charging device 5V 1.0A for PDA and laser module 2 0.2

RF505.42 Data cable 1

RF505.43 Bluetooth adapter 1

RF505.30 Packing case 1 1.2

IKP5_DB Database management system  (CD) 1

RF505UM User's manual 1

Calibration tools (option):

RF505.11 Calibration block 4

RF505Calibr Calibration software 
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The profilometer comes in the special case
that protects the device against any
possible damage during transportation.

8.     Device structure

8.1.     Basic components of the device and their functions

Fig. 1 shows basic components of the device:

Figure 1

(1) Digital readout device (personal digital assistant, PDA) 
(2) Laser scanning module 
(3) Calibration block
(4) Charging device
(5) Data cable  
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8.1.1.     Digital readout device

Digital readout device (PDA) is designed for control of the laser scanning module,
data reception from the scanning module, indication of measurement results, parameter
input, and data storage.

Figure 2

Fig. 2 indicates:
(1) Turn-on button
(2) Charging indication, red/blue LED
(3) Connector to PC USB-port or charging device 
(4) Flash memory card connector
(5) Stylus
(6) Bluetooth antenna 
Overall dimensions of PDA are shown in Figure 3:

Figure 3
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8.1.2.     Laser scanning module

The module is intended for laser scanning of the wheel surface.

Figure 4

Fig. 4 indicates:
(1) Turn ON button
(2) Indicator of turn ON (red LED)
(3) Indicator of Bluetooth connection (blue LED)
(4) Charging device connector 
(5) Support for mounting of the device on the wheel flange
(6) Magnetic support for mounting on the wheel side surface
(7) Charging indication, red/green LED
(8) Output window
(9) Rim measurement rod
· IKP-T
Overall dimensions of the standard scanning module are shown in Figure 5.

Figure 5
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· IKP-Short-T
Overall dimensions of the scanning module with a short handle are shown in Figure

6.

Figure 6

· IKP-SShort
Overall dimensions of the scanning module with a very short handle (Super Short

version) are shown in Figure 6.1.

Figure 6.1

· IKP-SShort-EB
Overall dimensions of the scanning module with a very short handle and an external

battery are shown in Figure 6.2.
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Figure 6.2

8.1.3.     Calibration block

Calibration block is intended for calibration and tests of the profilometer. Calibration
block is a metal imitator of the part of wheel with a definite profile.

Overall dimensions of calibration block are shown in Figure 1A of paragraph 30.3.
Also possible is supply of a unit with a profile made to the customer’s drawings.

9.     Operation principle
Operator mounts the laser scanning module onto the wheel to be measured. Having

received a command from PDA or PC, the laser module performs non-contact scanning of
the wheel surface. Measurement results (geometric parameters and profile of the surface)
are displayed on PDA, can be saved in the PDA memory, and transferred to the PC
database. Simultaneously, additional parameters can be saved: operator number, side
identifier (left or right wheel), axis number, locomotive (carriage) number, wheel pair
number, etc.

Video demonstration: https://riftek.com/eng/products/~show/instruments/railway-
devices/railway-wheel-profile-gauge-ikp

10.     Geometric parameters of the wheel under
control

Geometric parameters of the wheel are calculated automatically after laser
scanning of the wheel is completed. To calculate geometric parameters, use is made of
reference points on the wheel profile. Location of the reference points is defined by L- and
P-parameters. Values of L- and P-parameters preset in PDA are given in paragraph 14.4.
and can be changed by the user.

10.1.     Flange height, sH

Calculation of the flange height is determined by parameter L2.
The flange height is calculated as a distance measured vertically between the

flange top and the point of wheel rolling surface at any preselected distance (L2) away from
the inner face of the wheel tire.

https://riftek.com/eng/products/~show/instruments/railway-devices/railway-wheel-profile-gauge-ikp
https://riftek.com/eng/products/~show/instruments/railway-devices/railway-wheel-profile-gauge-ikp
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10.2.     Flange thickness, sD

Calculation of the flange thickness is determined by parameter L3 that specifies
Point 1 on the flange surface. There are two ways to specify the parameter:

Method 1

Height L3 is measured vertically
upward from a point of the wheel
rolling surface, the position of which
is defined by parameter L2.

Method 2

Height L3 is measured vertically
downward from the flange top.

The flange thickness is calculated as a distance measured horizontally at any
preselected height (L3) between two points (Point 1 and Point 2) lying on the opposite
sides of the flange top.

There are two ways to calculate the flange thickness:

Method 1

Point 1 is defined by parameter L3.
Point 2 is the intersection point of a
horizontal line and a line lying on the
internal face of the wheel.

Method 2

Point 1 is defined by parameter L3.
Point 2 is the intersection point of a
horizontal line and the flange surface.

Note: Both calculation methods can be performed simultaneously.
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10.3.     Flange slope, qR

Calculation of the flange slope is determined by parameters L1 and L3 (or L4).

Height L1 is measured vertically downward from the
flange top and determines Point 3 on the flange
surface.
Height L4 is measured vertically upward from a point
of the wheel rolling surface, the position of which is
defined by parameter L2 (wheel rolling circle), and
determines Point 4 on the flange surface.
Height L3 is described in paragraph 10.2.

There are three ways to calculate the flange slope:

Method 1
Calculation in millimeters

The flange slope is calculated as a
distance measured horizontally
between Point 3 and Point 1 (or 4). the
The PDA screen displays information
in millimeters.

Method 2
Calculation in degrees

The slope is calculated as the
inclination angle of a straight line
passing through Point 1 or 4. 
The PDA screen displays information
in degrees.

Method 3
Pass/Fail

The calculation is performed according
to Method 1.
The PDA screen displays information
only about whether the measured slope
meets the tolerance conditions or not.

10.4.     Wear parameters

The following wear parameters are calculated automatically:

Vertical wear  Wt is calculated as the difference between the measured flange height and the
flange height of the selected reference.

Horizontal wear  Wf is calculated as the difference between the measured flange thickness and the
flange thickness of the selected reference at height L3.

Corner wear  Wr is calculated as the distance along the normal to the tangent at the point at
height L5 from the wheel rolling circle of the measured profile, and the selected
reference.
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* Red color indicates the worn profile 

Hollow Hl is calculated as the difference between the maximum and minimum values
within the specified limits. 
The search limits:
- parameters of the minimum value [P7_1..P7_2]
- parameters of the maximum value [P8_1..P8_2]

Difference of
diameters

dD is calculated as the difference between diameter at point D1 and diameter at
point D2. 

Even wear  W1 is the maximum vertical wheel wear selected from several measurements.

Uneven wear W2 is the difference between the maximum wheel wear and the minimum wheel
wear (selected from several measurements).

10.5.     Angle parameters

The following profile parameters are calculated automatically:

Inclination A is calculated as the profile inclination angle (in degrees) at a point with coordinate
L8.

Angle 1 S1 is calculated as the inclination angle of the straight line (in percents) passing
through points on the wheel surface located at preset distance L6 from the wheel
face and the distance L6+10mm from the wheel face.

Angle 2 S2 is calculated as the inclination angle of the straight line (in percents) passing
through points on the wheel surface located at preset distance L7 from the wheel
face and the distance L7+10mm from the wheel face.
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10.6.     Rim parameters

The following rim parameters are calculated automatically:

Rim width L is calculated as a distance measured horizontally between the internal
and the external basic wheel surface.

Metal flow sS calculated as a distance measured horizontally between the external
basic wheel surface and external maximum wheel width 

Rim thickness sT is calculated as a distance measured vertically between the internal rim
diameter and a point on the wheel rolling circle located on any preset
distance L2 away from the wheel face.

L11 is an external wheel diameter.

10.7.     Wheel diameter

Diameter D is calculated by the formula:
D = 2*T +L10, 
T – rim thickness
L10 – diameter of the wheel center

10.8.     Parameters of tram wheels

The following parameters of the tram wheels profile are calculated automatically:

Flange thickness sD15 is calculated as a distance measured horizontally at the set
height (L15) between two points: 1st point is at the internal
flange surface, 2nd point is at the line lying on the internal
face of the wheel surface.

Flange thickness Df is calculated as a distance measured horizontally at the set
height (L3) from the surface of the wheel rolling circle
between two points lying on opposite sides from the flange
top.
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Reverse slope f is calculated as a distance measured horizontally from the
point on the internal flange side at the set height (L3) to the
point on the line lying on the internal face of the wheel. 

10.9.     Wheel defects

The following parameters of defects of the wheel surface are calculated:

Slide sP is calculated as a difference of the wear measurements in
two places of the wheel: on the slide and close to it (in the
place without defects) at the point on the wheel rolling circle
at any preset distance (L2) from the wheel face.

Cavity size hR is calculated as a difference of the wear measurements in
two places of the wheel: on the cavity and close to it (in the
place without defects) at any profile point.

Cavity area sR is calculated in the place of the maximum deviation.

11.     Coordinate system
When comparing the profiles, two variants of location of the coordinate system of

the wheel is possible to use.

Coordinate system origin

Top
When comparing and displaying profiles, the
coordinate system origin is located at the
intersection point of lines passing through the
profile top and the internal wheel surface.

Wheel rolling circle
When comparing and displaying profiles, the
coordinate system origin is located at the
intersection point of lines passing through the
wheel rolling circle.
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12.     First activation and measurement procedure
Charge accumulators of the laser module and indication device by connecting them

to charging devices (see par. 28). 

12.1.     Activation

· Turn the PDA on by pressing the button (1), Fig. 2. The PDA screen will show the
main program window containing: main menu; indicators of PDA and laser
module charging degree; indicator of Bluetooth connection. 

Button Assignment

Device Setting the PDA basic parameters (p.13) 

Parameters Setting the measurement parameters (p.14)

Settings Setting parameters of database, tolerances, and others (p.15)

Profiles View the wheelset profile (p.20.2.)

Measurement Run the measurement process (p.12.2.)

· Switch the laser module on by pressing and holding button 1 (Fig. 4) for several
seconds. When connecting the laser module, a red LED blinks (2). 

· After the laser module  is  switched on, some time will pass until automatic
wireless communication is set between the profilometer and the PDA, which is
accompanied by  blinking  of  a  blue  LED  (3) on  the laser module. The LED
goes out when the link is established. 

· The main program window will be updated.  

The Measurement button, indicator of Bluetooth connection, serial number of the
laser scanning module, and indicators of the charging degree will be active. 
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12.2.     Measurement

There are two types of measurements:
1. Rapid measurements without saving the results.
2. Measurements by using the selected scheme with saving results to database.
The measurement procedure by using type 2 is described in par. 18. How to select

the measurement type see in par. 13.1. 
Measurement by using the scheme (type 2) is used for full-featured work with the

profilometer with maintaining the database of measurements.

Attention! 
Before installing the scanning module onto the wheel, you need to remove the dirt from the areas,
where the laser scanning module will be in contact with the wheel surface. 
When installing the laser scanning module onto the wheel, avoid of strong impacts of its supports,
because it can lead to incorrect operation of the profilometer.

You need to inspect periodically the output window and basic supports of the laser scanning
module and to clean them of dirt. 
Do not clean the glass by using abrasive and aggressive cleaning agents. 

To perform the measurement, it is necessary to:
· Fix the laser module on the calibration unit or wheel by mounting the module

support (5) onto the wheel flange and pressing magnetic support (6) to the internal
face of the wheel.

· For the rim measurement, extract the rim measurement rod and hitch it up to the
rim.

Figure 6

· Make sure that the module is mounted correctly without any misalignment and
gaps.

· Press the Measurement button on the PDA display.
· With the Measurement button pressed, the laser module will scan the wheel

surface. During scanning time of about 1-2 seconds a red LED (2) is lit. 
· When scanning is competed, the PDA will show values of measured parameters

selected for presentation (see par.14.2.). 
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When the parameter goes beyond set limits its value is highlighted with red color: 

The Reference option enables/disables the display of the reference profile
parameters on the screen (highlighted in green).

· To view the wheel profile click the Profile button, and the PDA display will show
the scanned wheel profile, the measured parameters, and parameters of
calibration unit (or a wheel, chosen as a reference):

· If you scan the calibration block or the reference wheel and scanning results differ
from the reference values by nor more than 0.1 mm, the device is ready to work,
otherwise it must be calibrated in accordance with par. 27.1 or 30.

The Save button is not active in the Rapid measurements mode.
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13.     PDA program setting
Prior to starting work with the profilometer, PDA program setting must be

performed.
The window of basic parameters setting is called by pressing the Device button in

the main program window (par. 12.1.):

Button Assignment

Measure type Rapid measurements/measurements with saving results to database

Units of measurement Millimeters/inches

Date/time Date/time setting

Device type Device selection (IKP, IDK, IМR)

Language Language selection

Synchronization Synchronization with PC 

13.1.     Measurement type

Two measurement types are available:
1. Rapid measurements without saving the results.
2. Measurements by using the selected scheme with saving results to database.
To set the measure type, press the Measure type button. Then select the measure

type: Rapid measurement or Measurement by scheme. Press the Save button.

13.2.     Units of measurement

All parameters as well as measurement results can be presented in the Metric
system (millimeters), or in the English system of units (inches). To set the units of
measurement, press the Units button. Next, select Millimeters (mm) or Inches (in), and
press Save.
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13.3.     Date/time setting

Press the Date/Time button and set the date and time by using the buttons  .
Press the Save button.

13.4.     Device selection

The PDA Bluetooth-connection is automatically configured to work with the laser
scanning module supplied with the PDA. Moreover, the PDA provides operation with other
IKP scanning modules and measurement instruments for railway transport manufactured by
RIFTEK (Wheel Diameter Measuring Gauge, IDK; Back-to-Back Distance Measuring
Gauge, IMR).

To connect other devices, press the Device type button. The device selection
window contains 3 types of devices available for connecting to PDA: IKP, IDK, IMR. 

Each type of devices has a list of available devices (with which the connection has
been established earlier, and which have been saved in the IKP memory).

If the needed device is in the list, you can select it and press the Select button. The
PDA will try to connect to the selected device.
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To add a new device, press the Add button. The Device searching window will
appear:

To search for devices, press Start and wait for the search to complete:

Detected devices (with their serial numbers) will appear on the screen: 

Next, select the device and press the Save button to save the address of a new
device. 
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You can delete the device that you do not use anymore by pressing the Delete
button.

13.5.     Language setting

It is possible for the user to change the program language, form his own language
support files as well as change/edit the terminology used.

To select the language, press the Language button. Next, select the required
language support file and press the Select button.

If no such file is available, it is necessary to use the new files preparation procedure,
which is described in par. 22.2.4.1., and then load a new language file from PC to PDA as it
is shown in par. 23.1.3.

13.6.     Synchronization with PC

To transfer data between PDA and PC, it is necessary to synchronize them. There
are two ways of synchronization via USB cable.

When you select MS ActiveSync, synchronization with PC is performed via the
ActiveSync software (Windows XP), or via Windows Mobile Device Center (Windows
7).  

When you select Mass Storage, the device is detected in Windows as an external
storage device.

To select the type of synchronization, press the Synchronization button in the
Device window. Next, select the required type and press Save.
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To apply the changes, PDA will prompt you to restart. If you do not need to sync the

PDA with PC currently, you can restart the PDA later.

14.     Measurement parameters setting
The Parameters window, which is called from the main program window, is

intended for calculation settings of controlled parameters.

Button Assignment

Settings Calculation methods setting 

Show param. Selection of displayed parameters

L Parameters L Parameters setting
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14.1.     Calculation methods setting

To select the calculation method, press the Settings button. The following window
will appear:

After selecting the required parameters, press the Save button to save changes.

14.2.     Selection of displayed parameters

To enter the mode, press the Show param. button.

 To select/deselect the parameter to display, double-click in the Show/Hide column
opposite to the required parameter. After selecting, you need to press Save.

14.3.     L-parameters setting

To set L-parameters, press the L Parameters button.
In the table will be displayed only those parameters, which are necessary to

calculate the selected geometrical parameters of the wheel.

To edit the parameters, double-click in the Value column opposite to the required

parameter, and enter a new value in the Data Input window. Press the Enter button - .
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When you have set all parameters, press the Save button to save them.

14.4.     Preset parameters values

Values of L-parameters preset in the PDA are given in the Table:

L-
parameter

Default value Assignment

L1 2 mm Used for calculation of the flange slope (qR) 

L2 70 mm Defines position of the wheel rolling circle, and used for calculation:
- flange height (sH)
- flange thickness (sD)
- flange slope (qR)
- inclination angle (A)
- wheel diameter (D)
- rim thickness (T)
- wear (Wt, Wf, Wr)

L3 13 mm Used for calculation:
- flange thickness (sD)
- flange slope (qR)
- wear (Wf)

L4 13 mm An additional point for calculation of the flange slope (qR)

L5 10 mm Used for calculation of an angular wear (Wr)

L6 70 mm Used for calculation of slope of the rolling surface section (S1)

L7 105 mm Used for calculation of slope of the rolling surface section (S2)

L8 10 mm Used for measurement of the profile inclination angle at the required
point (A)

L9 140 mm Used for inverting the measurement direction (L9 – profile width)

L10 599,35 mm Used for calculation of the profile diameter (D)

L11 767 mm Used for calculation of the reference profile rim thickness (T)

L12 140 mm Used for calculation of the wheel whidth(L) and metall flow (sS)

L15 13 mm Used for calculation of the flange thickness of tram wheels (sD15)

P7_1 
P7_2
P8_1
P8_2

50 mm
105 mm
110 mm
130 mm

Used for calculation of the hollow (Hl)

D1 
D2

70 mm
107,5 mm

Used for calculation of the hollow (Hl)
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15.     Setting the database parameters, tolerances and
measurements schemes

The Settings window is intended to set the database parameters, tolerances,
measurements schemes, etc.

Button Assignment

Database Database selection

Reference Reference profile selection 

Scheme Setting of measurement scheme

Tolerance Setting of tolerances

Wheel type Wheel type selection

15.1.     Selection of the current database

You can save the measurement results to the PDA database when it is necessary.
The program makes it possible to create and store several database files related to the
date of measurement.

To select the database file, press the Database button.

To create a new database, press the Add button. The window for entering a name
of a new database will appear.

By default, it will be prompted to form the database file with the name
wp_yy_mm_dd.ikp, where yy_mm_dd is the current date:

yy   – the last two digits of the year;
mm – month;
dd  – day.
You can agree with this name, or enter another:
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To select a database from a list, activate the line and press Select. The selected
file will be marked with a "dot" symbol. 

To delete the database file, activate the line and press Delete. If you delete the
current database, the error message will appear.

15.2.     Reference profile selection and installation

The program allows to compare the scanned profile of the wheel with the reference
profile. To select the reference profile, press the Reference button.

To select the reference file, activate the line and press Select. The selected file will
be marked with a "dot" symbol.

To delete the reference file, activate the line and press Delete. If you delete the
current reference, the error message will appear.
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15.2.1.     Writing the reference profile to the database

Reference profiles are stored in the PDA database as profile description files with
.ref extension. The PDA is supplied with several pre-installed profiles. 

If there is no required reference profile in the database, the user can request the
missing profile from RIFTEK (free service), and then transfer the received profile to the
PDA as shown in Par. 23.1.4.

15.3.     Selection and formation of the measurement scheme

The measurement scheme is meant as a sequence of making
measurements/processing of wheels in the rolling stock with specified parameters of each
wheelset (wheelset numbers, car numbers, series, etc.). The program automatically offers
the operator to perform measurement of the wheel in accordance with selected scheme of
wheel processing. The program contains several preset schemes. Besides, the user can
form his own measurement scheme.

15.3.1.     Selection or removal of the measurement scheme

To select the measurement scheme file, press the Scheme button.

To view the scheme, you need to activate the line containing the scheme file name

and to press the View button .

Arrows in the figure show direction of processing of wheel pairs as well as the
names assigned to wheels (1L-first axis, left side; 2L-second axis, left side; 1R-first axis,
right side, etc.).

To select the scheme file, activate the respective line and press Select. The
selected file will be marked with the symbol "·". 

To delete the scheme file, activate the respective line and press Delete. If you
delete the current scheme, the error message will appear.
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15.3.2.     Formation of a new measurement scheme

To form a new measurement scheme, press Add. The window for entering the
measurement scheme name will appear.

Type the scheme name by using the on-screen keyboard. Then press the Enter

button - .

Next:
· select the number of cars;
· select the number of axles; 
· select the wheel processing scheme out of the options suggested;
· press Save.

You can look at the formed scheme by pressing the View button - .
This method of the measurement scheme formation allows to create only simple

schemes without specifying the wheelset numbers, car numbers, series, etc. To form a
complete scheme, see par. 29.

15.3.3.     Loading of a new measurement scheme

If you can not create a new scheme as described in the previous paragraph, you
can use the special program for PC (see par. 29), and then upload that scheme to the PDA
as described in par. 23.1.5.

15.4.     Setting of tolerances

The program automatically controls measured geometric parameters for going out
beyond the tolerances set. It is possible for the user to create groups of tolerances. Control
of parameters will be performed for a selected group. 

To select the current group of tolerances, press the Tolerance button.
The table will show tolerances only for the selected geometric parameters of the

wheel.
The red color indicates the maximum/minimum critical values of parameters. The

orange color indicates the maximum/minimum values, which are close to critical values.
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To select the group of tolerances, activate the line and press Select. The selected
file will be marked with a "dot" symbol.

To delete the tolerance, activate the line and press Delete. If you delete the current
tolerance, the error message will appear.

To edit the tolerance, activate the line and press Edit.
To add a new tolerance, activate the line with the type name and press Add. You

will see on the screen:

To change the type name, it is necessary to set cursor in the Name of Tolerance

field, and to enter a new value in the appeared window. Then press the Enter button - .
To edit the value, it is necessary to double-click on the Min/Max/War.Min/War.Max

column opposite to the specific parameter, and to enter a new value in the emerged
window. Then press the Enter button. If any parameter has a zero value, the tolerance will
not be used.

To save changes, press Save.

15.5.     Wheel type selection and installation

If several wheels types are used, it is possible to set definite measurement scheme,
reference profile and L-parameters for every wheel type 

For example, we have three types of wheels: WheelType1, WheelType2,
WheelType3. Every time for a new wheel type we can measure L-parameters, scheme,
reference and tolerances, or we can define these values for every wheel type, and select
only the required type.  

Example
WheelType 1: Reference 1, Scheme 1, Tolerance 1, L-Parameters 1;
WheelType 2: Reference 2, Scheme 2, Tolerance 2, L-Parameters 2;
WheelType 3: Reference 3, Scheme 3, Tolerance 3, L-Parameters 3;

To select the wheel type, press the Wheel type button.

To select the wheel type, activate the respective line and press Apply. The selected
file will be marked with the symbol "·". 
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To delete the wheel type, activate the respective line and press Delete. If you delete
the current type, the error message will appear.

To edit the wheel type, activate the respective line and press Edit. 
To add a new wheel type, activate the line with the type name and press Add. View

on the screen:

To change the type name, it is necessary to set cursor in the Name field, and to

enter a new value in the appeared window. Then press the Enter button - .
Next:
· select the reference profile (Reference);
· select the scheme (Scheme);
· select the tolerance (Tolerance);
· set Settings (Settings button, see par. 14.1.);
· set the displayed parameters (Show param. button, see par. 14.2.);
· set L-parameters (L Parameters button, see par. 14.3.);
· press Save.

16.     Updating of PDA software
You can view the software version in the main program window: 

The latest software version can be downloaded from the website:
www.riftek.com/media/documents/ikp/Ikp5_PDA_Software.zip
Procedure of PDA software updating is described in par. 23.1.6. of this manual.

http://www.riftek.com/media/documents/ikp/Ikp5_PDA_Software.zip
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17.     Shutdown

To shutdown the PDA, press the Shutdown button - . 

18.     Measurements with database maintenance
There are two types of measurements:
1. Rapid measurements without saving the results.
2. Measurements by using the selected scheme with saving results to the database.
Procedure of rapid measurements is described in par. 12. How to select the

measurement type, see par. 12.2. 
The second type is used for a fully functional work with the profilometer with

maintenance of the measurements database. 
When Bluetooth-connection is established, you can start to measure by pressing the

Measurement button in the main program window. The window of wheelset parameters will
appear on the screen:

Parameters fields will be filled in accordance with the selected measurement
scheme. If needed, you can fill/edit the required fields, and press the Save button to save
changes. The selected scheme will be displayed on the screen:

Designations and buttons:
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an ordinal number of the car to be measured (number of cars in the rolling stock)

edit the wheelset parameters

pass to the previous/next wheel 

pass to the previous/next car

a measured wheel 

a wheel to be measured the next time

a non-measured wheel 

a measured wheel to be measured again 

measurement

18.1.     Measurement

· Press the Measure button in order to measure the wheel offered by the program
(highlighted in green). The laser module will scan the wheel surface. 

· Upon completion of the scanning process, the PDA will show the values of
selected geometrical parameters.  

When the value is beyond the tolerances, it will be highlighted in red:

The program allows to display only parameters of the measured profile.To hide the
reference values, you need to untick the Reference box.
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· To view the wheel profile, press the View button - . The scanned wheel profile
and the selected reference profile will be displayed on the PDA screen.

For more information, see par. 20.2.
· To repeat the measurement, press the Measure button. 
· When a satisfactory result is obtained, press the Save button to save it.
· The program will offer to pass to the measurement of the next wheel in

accordance with the selected scheme of measurement.

· To view the results of previous measurements, you can use the arrows. If you
select the measured wheel, the saved wheel parameters will be displayed on the
PDA screen.
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you to replace the existing database file with the new one.

18.2.     Measurement of even/uneven wear

Measurement of an even/uneven wear is slightly different from a standard
measurement. To obtain the result of the wear, it is necessary to perform several
measurements at different points of the wheel. When passing to the measurement window,
an additional button Accept will appear on the screen.

After each performed measurement, you need to press Accept to save current
values of the wear. At subsequent measurements the program will automatically find the
maximum and minimum wear of the wheel and calculate an even/uneven wear.
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When a satisfactory result is obtained, press the Save button to save it.

18.3.     Measurement of defects

IKP allows to measure defects of wheelsets.
· Slide size (sP)
· Cavity size (hR)
· Cavity area (sR)
Measurement of defects differs from the standard measurement.
The procedure of measuring the slide (cavity) is described below: 
· Perform the measurement at the profile point that do not have any defects (slides,

cavities), which can be detected visually. 

· If you obtained a satisfactory result, press the Apply button. The checkboxes
Slide and Cavity will appear on the screen. 

· Select the defect that you need to measure (tick the required checkbox).
· Place the profilometer properly (a laser beam must pass through the measured

defect).
· Press the Measure button to start the measurement.
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Upon completion of the measurement, the program calculates the value of selected
parameter.

When a satisfactory result is obtained, press Save to save data to database.

19.     Measuring by IKP, IDK, IMR, and saving to
database

How to use the PDA with other devices is described in the corresponding User's
Manuals.

It is often needed that the measurement results obtained from different devices
were stored in one database. In this case, all entered parameters of the specific wheelset
must be the same in all devices.

These parameters are:
· Date
· N wheelset
· Series 
· Number
· Axle 
· Side (besides IMR)

20.     Browsing the database
To browse the saved data, press the Profiles button in the main window. The PDA

screen will display information about the current database, quantity of saved profiles, table
with saved profiles, and measured values of selected parameters.

Buttons:

Browse the profile of selected wheel 

Delete the selected wheel
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Add a filter

Delete a filter 

Save the reference file

20.1.     Data filtering

To add a filter, you need to press the Filter button, and to set filter parameters in the
appeared window.

An example of filtering by the Axle parameter:

The filtered field will be highlighted in yellow: 

To delete the current filter, you need to press .

20.2.     Visualization of the wheel profile

To browse the wheel profile, you need to press the Profile button - . The
scanned wheel profile and the profile of selected reference will be displayed on the PDA
screen. 
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Zoom in

Zoom out

Standard image scale

Browse the profile wear 

An example of a zoomed image:

An example of visualizing the profile wear.
Information about the wear area is displayed on the screen. A positive wear area is

highlighted in green, a negative one - in blue.

21.     Installation of software on PC and startup

21.1.     Installation of database support software

The ikp5_DB software is intended for maintaining wheel sets wear database on a
personal computer (the updated version of the program can be downloaded from
www.riftek.com/media/documents/ikp/Ikp5_PC_Software.zip). 

To install the software, insert a compact disk to the PC CD drive, select and start
the Install_Ikp5.exe file in the Software folder. Follow guidelines of the installation wizard.
By default, the software will be installed in the following directory C:\Program Files (x86)
\Riftek, LLC\Ikp5_db\.

21.2.     Synchronization of PDA and PC

There are two ways of synchronization via USB cable to transfer data between PDA
and PC:  

· MS ActiveSync
· Mass Storage 

http://www.riftek.com/media/documents/ikp/Ikp5_PC_Software.zip
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When you select MS ActiveSync, synchronization with PC is performed via the
ActiveSync software (Windows XP), or via Windows Mobile Device Center (Windows
7), which must be installed on PC.

It is necessary to select MS ActiveSync as the synchronization type (see par.
13.6.).

When you select Mass Storage, the device will be detected in Windows as an
external storage device.

It is necessary to select Mass Storage as the synchronization type (see par. 13.6.).
To check if the MS ActiveSync synchronization is correct, switch on the PDA and

connect it to the USB port of the PC by the supplied cable. If the connection is successful, a
message about it will appear on the screen:

21.3.     Program startup

To start the program, click Start > All programs > Riftek, LLC > IKP5_DB >
Ikp5_DB.exe. View of the main program window is shown below.



IKP-5 Series, Model 2017 Year [Revision 1.1.0] 10.11.2017

Laser Wheel Profilometer. IKP-5 Series, Model 2017 Year

43

22.     User settings of the program

22.1.     Parameters setting

To go to the window of parameters setting, click Settings > Parameters in the

main window, or click .

The window of parameters contains 4 tabs:
· Wheelset's parameters
· Calculated parameters
· L parameters
· Measurement method

22.1.1.     "Wheelset's parameters" tab

This tab is intended to select parameters, which will be displayed on the screen
when viewing the database.

If the parameter is ticked, its value will be shown in the table of results and in the
table of profiles. 



44

Laser Wheel Profilometer. IKP-5 Series, Model 2017 Year

IKP-5 Series, Model 2017 Year [Revision 1.1.0] 10.11.2017

22.1.2.     "Calculated parameters" tab

This tab is intended to select the wheelset geometrical parameters, which will be
calculated and displayed on the screen when viewing the database.

Description and functions of parameters are the same as in the PDA software (see
par. 10.).

22.1.3.     "L-parameters" tab

This tab is intended to set the values of reference points for calculated geometrical
parameters of the wheelset.

Description and functions of the reference points are the same as in the PDA
software (see par. 10.).

22.1.4.     "Measurement method" tab

This tab is intended to select the calculation method.

Description and functions of the measurement methods are the same as in the PDA
software (see par.10.).
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22.1.4.1.     Selection of measurement units

All parameters and measurement results can be in the Metric system (millimeters),
or in the English system (inches). 

To set the units of measurement, you need to select mm or inches in the Units of
measurement field. After saving the changes, all information will be displayed in the
selected units of measurement.

22.2.     Database settings

22.2.1.     Setting the path to database

It is possible for the user to change the drive and the directory of the profiles
database storage. In the main window, select File > Path to DB...

Next:
· click Ok
· specify a new path to the database 
· confirm the creation of a new database 

All database files will be copied to the specified path.
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22.2.2.     Creation of empty database

To create an empty database, select File > New DB.

All data except the reference files will be deleted from the database. At the same
time, the DB(dd.mm.yy) directory will be created in the installation directory whereto all the
deleted data will be copied (dd.mm.yy – current date). If necessary, these data can be
restored (see par. 22.2.3).

22.2.3.     Import of database

To import data to the database from the other database, you need to:
· Select File > Import Data.
· Select the directory with DB files in the left window. All files will appear in the right

window:

· Click OK to import data.

22.2.4.     Selection of software language

To change the software language, select Settings > Language and select the
required language support file.
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22.2.4.1.     Preparation and installation of the language support file

The user can change the language, form his own language support files as well as
change/edit the terminology used. Language support files are located in the directory used
in the process of installation. By default, the following directory is used: C:\Program Files
(x86)\Riftek, LLC\Ikp5_db\Language\. 

The directory contains two files, RUS.lng and ENG.lng, to support Russian and
English languages respectively. 

To create the support file for any other language, it is necessary to: 
· copy one of the existing files, for example - ENG.lng, under the other name, for

example - DEU.lng; 
· edit the renamed file by using any text processor, namely, change all terms and

phrases to analogous ones from the required language;
· save the edited *.lng file in the Language directory.
To change and edit terminology, it is necessary to:
· edit the corresponding language file by using any text processor;
· save the edited *.lng file in the Language directory.

22.3.     Registration data

22.3.1.     Selection of the organization

To add/chose the user organization, select Registration > Organization.
Subsequently, this information will be used in automatic generation of reports.

Buttons:

Add a new organization

Delete the selected organization

Edit the selected organization

Exit the mode

To select a current organization:
· Click Edit
· Tick the depot
· Click Save
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22.3.2.     Registration of operators

Steps to follow: Registration > Operator. Operators data are used for identifying
operators by Number.

Functions of buttons are similar to those in par. 22.3.1.

22.3.3.     Registration of series

Steps to follow: menu Registration > Series. Registered series of cars or
locomotives are displayed in the emerged window.  

When registering a new series, a new entry for this series will be added in the table
of tolerances automatically (see par. 22.3.5).

Functions of buttons are similar to those in par. 22.3.1.
When adding a new series, it is necessary to enter the name of the series and to

select the reference profile for it. Flange parameters of the selected profile will be
calculated and added to the table of tolerances automatically after saving the series (see
par. 22.3.6).
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22.3.4.     Registration of car/locomotive numbers

Steps to follow: menu Registration > Number. Registered numbers of
cars/locomotives are displayed in the emerged window.  

Functions of buttons are similar to those in par. 22.3.1.

22.3.5.     Registration of tolerances

Steps to follow: menu Registration >Tolerance. Registered series of
cars/locomotives with boundary values of calculated geometric parameters of the wheelset
are displayed in the emerged window. 

Only parameters, which were selected in the list of parameters, are available for
editing (see par. 22.1.2.). 

Maximum/minimum critical values of parameters are indicated with a red color. An
orange color indicates maximum/minimum values of parameters, which are close to critical.

The Norm value is calculated and added to the table automatically when
adding/editing the series of the selected reference (see par. 22.3.3).

22.3.6.     Registration of reference profiles

The program comes with several preset profiles. In addition, the supplied disc with
software contains the base of reference profiles. Profiles are in the Reference Profiles
directory and divided into separate directories for each country.

In addition, the user can form a description of the required profile himself or request
it from RIFTEK (free service). 

To browse available profiles, select Registration > Reference:
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The window of profiles displays the table with the list of reference profiles, saved to
database, and a graphical view of the selected profile.  

Buttons:

Delete the reference profile 

Import the reference profile from *.ref file

Export the reference profile to *.ref file

Exit the mode

22.3.6.1.     Request and registration of the profile file

To get .ref file of reference profile send the drawing of profile to RIFTEK
(info@riftek.com). Register the received .ref file as follows:

· click Import
· in the window appeared indicate the way to the .ref-file
· click Open
The profile will be added to the base of reference profiles.
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23.     Data exchange between PDA and PC
To exchange data between PC and PDA, you need to select the device: File >

Device > RF303M-PDA. 

Data exchange between PC and PDA is performed by means of direct cable
connection of PDA to PC USB-port (special RF505.42 cable is supplied).  

There are two ways of synchronization via USB cable:
· ActiveSync
· Mass Storage 
For more details see par. 21.2. 

23.1.     ActiveSync synchronization

When you select this type of synchronization, additional features of data exchange
with PDA will be available:

· Transfer of database files to PC 
· Transfer of language files 
· Transfer of reference profile files 
· Transfer of processing scheme files 
· PDA software update

23.1.1.     Transfer of database file to PC

To transfer the database file from PDA to PC, it is necessary to:
· select PDA > Import Data

· mark the required files in the emerged window and click OK
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Double-click on the selected file in order to see information about saved data.

23.1.2.     Transfer of language file from PC to PDA

To transfer the language file from PC to PDA, it is necessary to:
· select PDA > Language file > Export

· select the required file
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If transfer is successful, the screen will show:

23.1.3.     Transfer of language file from PDA to PC

To transfer the language file from PDA to PC, it is necessary to:
· select PDA > Language file > Import

· select the required file 

If transfer is successful, the selected files will be saved to the specified path.

23.1.4.     Transfer of reference profile files from PC to PDA

To transfer the reference profile file from PC to PDA, it is necessary to:
· select PDA > Reference file > Export
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· select the required .ref file
If transfer is successful, the screen will show:

23.1.5.     Transfer of processing scheme file from PC to PDA

To transfer the processing scheme file from PC to PDA, it is necessary to:
· select PDA > Scheme file > Export

· select the required .sch file
If transfer is successful, the screen will show:

23.1.6.     Updating of PDA software

The latest software version can be downloaded from the website:
www.riftek.com/media/documents/ikp/Ikp5_PDA_Software.zip. 
To transfer the update file to PDA, it is necessary to:
· select PDA > PDA update 

· select file for transfer

http://www.riftek.com/media/documents/ikp/Ikp5_PDA_Software.zip
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If transfer is successful, the window will appear:

23.2.     Mass Storage synchronization

When you select this type of synchronization, PDA is detected as an external
storage device. Therefore, the only Import Data item is active. Transfer of
language/scheme/reference files  from PDA to PC and back can be performed by simple
copying.

To transfer database files from PDA to PC, it is necessary to:
· select PDA > Import Data
· specify the path to the database on PDA (by default, SDMMC\Autorun\DB)

· mark the required files in the emerged window and click OK

Double-click on the selected file in order to see information about saved data.
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24.     Working with profilograms and wear
calculations

24.1.     Browsing the graph and profile coordinates

To browse the saved profiles of the rolling surface, select Database > Profiles, or

click the Profiles button - .

At the left side of the window you can see the Table of profiles tab, which contains
a list of saved profiles. The table displays only those identification parameters of the wheel,
which were selected in the parameters window (see par. 22.1.).

When selecting a profile, it is possible to browse a graphical image and geometric
parameters of the measured wheel. To browse the coordinates of the selected profile, you
need to click the Profile Values button. After that, an additional tab with the measured
coordinates will appear.

Buttons:

Show/hide the Wear graph

Show/hide the Profile Values tab

Show/hide the Profile alignment tab 

Save the profile image to file (.bmp file)

Print the profile image 

Change the background color of the graph 

Zoom in/out the profile graph 

Calculate geometric parameters of the wheel 
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24.2.     "Parameters" tab

Calculated geometric parameters of the profile as well as L-parameters values are
displayed on the Parameters tab, which is at the bottom of the window.

If needed it is possible to change settings of the calculated parameters or support
points (see par. 22.1).

24.2.1.     Selecting a profile to compare

There are two ways to compare:
· with the reference profile,
· with the measured profile.
To compare the measured profile with the reference one, it is necessary to tick the

Reference box.
When comparing with the reference profile, select the required reference profile in

the drop-down list.

To compare two measured profiles (for example, profiles of left and right wheels), it
is necessary to tick the Measured box. The Table of profiles tab will show an additional
table for selecting a profile to compare.

24.2.2.     Selecting L-parameters values

When calculating the geometric parameters of wheelsets, the specified support
points are used (see par. 22.1.3). There are two variants of L-parameters:

· General parameters 
· Profile parameters 
When selecting General parameters, values of L-parameters will be taken from the

default parameters file (see par. 22.1.3).
When selecting Profile parameters, values of L-parameters will be taken from the

profile file, i.e. the values, which were set in PDA when measuring the wheelset (see par.
14.3.).

Values of L-parameters are displayed on the screen in the table of parameters.
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If necessary, it is possible to edit any value and to recalculate values of geometric
parameters of the flange. To do it, click Calculate. Parameters of the measured profile and
selected reference will be recalculated.

24.2.3.     Geometric parameters of the profile

The table of calculated geometric parameters displays only those parameters,
which were selected in the parameters window (see par. 22.1.2).

Parameters, which are beyond the set tolerances, are highlighted in red/orange
(see par. 22.3.5).

24.3.     Wear calculation

24.3.1.     Fast wear calculation

To obtain fast calculation of the profile wear at a certain point relative to the
reference, put cursor bar to any of the profiles, and when a cross-like (+) mouse cursor
appears press the left mouse key. The resulting screen will show the value of the coordinate
difference between profiles taken along X- and Y-axes, as shown by arrows:

To remove size indication from the screen, it is necessary to put cursor to any of the
profiles and press the right mouse key.
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24.3.2.     Wear calculation at all points

To calculate the wear at all points of the measured profile, it is necessary to click the
Wear button. Calculated wear will be displayed on the screen in a graphic form:

The graph displays positive and negative values of the wear area. Value of the wear
area is calculated in square millimeters with respect to the selected reference profile:

To view the table of wear values, it is necessary to select Profile Values > Wear.
The table will show deviations of the selected profile from the reference profile in two
directions (X and Y).

24.3.3.     Export to Excel, DXF, REF

To export the table to the Exсel or DXF format or to create the reference file (REF),
it is necessary to right-click on the table. The pop-up menu will appear:

Select the needed menu item.
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24.4.     Alignment of profiles

For alignment (vertical translation) of profiles, you need to click the Alignment
button. The program will display an additional tab, where you can select a profile:
Reference or Measured. The selected profile will be marked with red.

   
After selecting the profile, the screen will display the maximum and minimum

deviations of the selected profile from the reference profile [Min dY..Max dY].
Next, specify the translation step and move the profile by using the Up/Down,

Left/Right buttons.

To save the changed profile, go to the tab of identification parameters of the profile
and click Save. 

To create a new profile, it is necessary to change the identification parameters of
the profile.



IKP-5 Series, Model 2017 Year [Revision 1.1.0] 10.11.2017

Laser Wheel Profilometer. IKP-5 Series, Model 2017 Year

61

24.5.     Superposition of profiles

To superimpose several changed profiles, you need to tick the required profiles in
the left table. Selected profiles will be displayed in different colors. 

24.6.     Rescaling

To change the image scale, mark a part of the image with the left mouse key, move

the image by holding it with the right mouse key pressed, or with buttons Increase - 

, Decrease -   and Show all - .

25.     Implementation of minimum wheel truing
function

Select Tools > Analysis of profiles. The analysis of wheel profiles allows to
choose such a type of the profile from the reference profiles, for which the total truing depth
of two wheels would be minimal.

In the first table of profiles, select the first required profile of the wheelset (left
wheel); in the second table of profiles, select the second required profile of the wheelset
(right wheel).

The program allows to perform the automatic analysis by all the reference profiles,
which stored in the database, or by the selected profile only.

· Automatic analysis
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Tick the box and click the Analysis button. Profiles in the table of references must
not be marked.

· Analysis by the selected profile
Select the reference profile for analysis and click the Analysis button.

To know the wheel cutting depth in a certain point, put the cursor to any profile, and
when a cross-like (+) mouse cursor appears press the left mouse key. The resulting screen
will show the value of difference between profiles along X- and Y-axes, as shown by arrows.
To remove size indication from the screen, put cursor to any of the profiles and press the
right mouse key.
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26.     Scanning and editing of data

26.1.     Scanning and filtering of data

Select Database > Table in the menu or click the Table button - . The form with
results will be as follows:

· Hide/show the field 
The table displays the identification and geometric parameters of the wheelset,
which are selected for displaying in the parameters settings (see par. 22.1.1 and 
22.1.2).
· Sorting of data
To sort data for any of the fields, click the left mouse key on the header of the field

column:

To cancel data sorting, press the Ctrl key and click the left mouse key on the
header of the field column.

· Filtering of data 
In order to filter data in any of the fields, click the left mouse key on the header of the

field grouping, and select the required value in the emerged drop-down list:

To cancel filtering, all steps should be taken in the reverse order.
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· Data grouping
To group data for any of the fields, click the left mouse key on the header of the field

column, and, with the mouse key pressed, drag it onto the table header:

· Changing of the field position order 
To change the field position, click the left mouse key on the header of the field

column and, with the mouse key pressed, drag it to the required position:

Buttons:

Add the wheel pair 

Delete the selected wheel pair 

Delete all wheel pairs 

Edit the selected wheel pair 

Export the coordinates of wheel pairs to the Excel format

Report preparation 

26.2.     Editing data

You can edit, add and remove data in/from the database.
· Editing data
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To edit the current entry, click the Edit button and input/change required values of
parameters. After the editing is complete, click the Save button.

· Adding data

To add a new data entry, click the Add button and type required parameter values.
After the editing is complete, click the Save button.

· Deleting data
To delete the current entry, click the Delete button and confirm the deletion.

· Deleting all selected data
If it is necessary to delete not only one entry but several entries combined by some

condition, filter the data according to the corresponding attribute (see par. 26.1.), click the
Delete all button and confirm the deletion.

26.3.     Report preparation

When staying in the mode of scanning and editing data, the user can prepare
reports in Excel, RTF, PDF formats, or print out reports. When preparing the report, the
sorting used at the moment is taken into account.  

To generate a report, press the Report button. The program will offer to select the
following options:
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26.3.1.     Excel-format report

To prepare a report in Excel format, select Report in Excel and click ОК. 

26.3.2.     Report for printout

To prepare the report for printout, select Report for printout and click ОК. Data
will be presented in the form of report ready for printout. 
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The top toolbar contains the following buttons for operating with reports: 

· To printout the report, click .

· To save in PDF format, click .

· To save in Excel, RTF or PDF, click  and select the format you need:

27.     Taking measurements under PC control (without
PDA)

The laser scanning module (RF505) can work under direct control of PC without
PDA. To work under direct control of PC, it is necessary to select File > Device > RF505-
Profilometer in the main menu.

In the main menu of the program, the PDA tab will be replaced with the
Profilometer tab.

The menu contains two available items:
· Calibration 
· Measurement 
Before you start working with the profilometer, it is necessary to set the COM-port

for Bluetooth-connection between the laser scanning module and PDA. The procedure is
described in the User's manual that comes with the Bluetooth-adapter.
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27.1.     Calibration

To calibrate the device, select Profilometer > Calibration, or click . 

27.1.1.     Bluetooth-connection

Select the COM-port and click the Connect button.

For more information, refer to p. 30.

If the connection is successful, the device will be identified, and calibration
parameters will be obtained. The status will be changed to Connected.

The table of calibration parameters: 
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Buttons:

Measurement

Reading calibration parameters 

Writing calibration parameters 

Automatic setting of calibration parameters

The Auto calibration button will be active, if at least one measurement of the profile is performed
and the reference profile is selected.

27.1.2.     Calibration of the profilometer

· Place the profilometer on the calibration block. 
· Select the reference profile from the list (Compare > Reference). 
· Perform the measurement (the Measurement button )
· Perform the calibration (the Autocalibr button).
· Save calibration parameters (the Write param. buton).

Calibration parameters can be set manually. To do it, click left mouse key on the
field of the required parameter value, and enter the new one.

Attention! Writing incorrect values of some parameters can lead to the incorrect work of the
device.

Buttons functions, work with profiles and calculation of required parameters are
described in par. 22.
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27.2.     Measurement by using PC

To measure, select Profilometer > Measurement, or click the button . 

When the Bluetooth-connection is established (see par. 27.1.1), the Measurement
button is active.

27.2.1.     Saving of data

· Place the profilometer on the wheel 
· Perform the measurement (the Measurement button) 
· Enter the identification parameters of the wheelset 

· To save results, click Save 
· The measured profile will be saved to the database 
Buttons functions, work with profiles and calculation of required parameters are

described in par. 22.
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28.     Annex 1. Charging procedure
· Switch off the PDA (laser module)
· Connect the charging device to PDA (laser module)
· Connect the charging device to 220V AC
· Time of charging - 4 hours (full-charge indication: PDA - blue LED is lit; laser

module - green LED is lit)
· Disconnect the charging device from 220V AC
· Disconnect the charging device from PDA (laser module)

Attention! Please follow the sequence of these points.

29.     Annex 2. Program for creating the measurement
schemes

To create the measurement schemes, use the special program
SchemeBuilder.exe. When the program is started, the main window appears on the
screen:

To form the scheme: 

· Enter the number of cars 

· Enter the number of axles in every car 
· If the measurement of the car is performed in the reverse order, tick the box

· Select the type of the scheme 

· Click the button to accept 
· Next, enter parameters of all wheelsets sequentially for each car 

· The fields Axle and Car are used to navigate through the scheme 



72

Laser Wheel Profilometer. IKP-5 Series, Model 2017 Year

IKP-5 Series, Model 2017 Year [Revision 1.1.0] 10.11.2017

· Click the Save scheme button 
· Enter the name of the scheme in the dialog box window

The program allows to edit the existing scheme. To edit the scheme, click the Load
scheme button and select the *.SCH file. After loading, you can edit and save the wheelset
parameters.

To transfer the scheme file to PDA, use the procedure described in par. 23.1.5.
Clarification. The measurement scheme is a text file with extension .sch. User can

create and edit such file by using any text processor. 
Example:

Scheme_EXAMPLE 
{ 

1d-|SM 3|7102|1l|11|SU11|111|1r|11|SU11|111|2l|12|SU12|112|2r|12|SU12|112|3l|13|SU13|113|3r|13|SU13|113|4l|14|SU14|114|4r|14|SU14|114|; 

2d-|SM 3|7202|1l|21|SU21|211|1r|21|SU21|211|2l|22|SU22|212|2r|22|SU22|212|3l|23|SU23|213|3r|23|SU23|213|4l|24|SU24|214|4r|24|SU24|214|; 

3d-|SM 3|7302|1l|31|SU31|311|1r|31|SU31|311|2l|32|SU32|312|2r|32|SU32|312|3l|33|SU33|313|3r|33|SU33|313|4l|34|SU34|314|4r|34|SU34|314|; 

4i-|SM 3|7402|4r|44|SU044|414|4l|44|SU44|414|3r|43|SU43|413|3l|43|SU43|413|2r|42|SU42|412|2l|42|SU42|412|1r|41|SU41|411|1l|41|SU41|411|; 

5i-|SM 3|7502|4r|54|SU54|514|4l|54|SU54|514|3r|53|SU53|513|3l|53|SU53|513|2r|52|SU52|512|2l|52|SU52|512|1r|51|SU51|511|1l|51|SU51|511|; 

6i-|SM 3|7602|4r|64|SU064|614|4l|64|SU64|614|3r|63|SU63|613|3l|63|SU63|613|2r|62|SU62|612|2l|62|SU62|612|1r|61|SU61|611|1l|61|SU61|611|; 

} 

Where:
1d – coaches arranged in direct order (1 – sequence number) 
1i – coached arranged in the reverse order (1 – sequence order)
SM3 – coach series 
7102 -number
1l – sequence number of wheel pair and the side (l- left/r-right) 
11 – axle number 
SU11 – name of wheel set 
111 – running distance of wheel set
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30.     Annex 3. Testing and calibration
We can supply the profilometer complete with an RF505.11 calibration-wheel

simulation unit (Fig. 1A) and RF505Calibr calibration program that are designed for
periodic testing and self-calibration of the profilometer.  

Instead of the calibration unit use can be made of the wheel with known profile
entered to the database (see par. 22.3.6).

Before start the testing and calibration process, it is necessary to set the COM-port
for Bluetooth-connection between the laser scanning module and PDA. The procedure is
described in the user manual that comes with the Bluetooth-adapter.

When you add the device, Windows will ask for the pairing code. The pairing code
for each device consists of 4 symbols and is formed according to a serial number. For
example, if a serial number is 04217, then a code will be 0427; if a serial number is 01318,
then a code will be 0138, etc.

30.1.     Preparation for testing/calibration

· Install the RF505 program on the PC
· Install Bluetooth-connection between the scanning module and PC 
· Place the profilometer on the calibration unit 
· Run RF505 program

· To install Bluetooth-connection, select the required port.

The device will be identified, and calibration parameters will be read.
· To perform the measurement, pass to the Profile tab and click Measurement.

After measuring, the display will show the measured profile and the calculated
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geometric parameters of the profile: Height (Sh), Thickness (Sd), Slope (qR).
Parameters are measured at support points L1, L2, L3.

· To compare with the reference, tick the Compare box and select the required
reference profile in the Reference drop-down list. 

30.2.     Testing

To carry out automatic testing, do the following steps:
· Tick the N meas. box (number of measurements)
· Specify the number of measurements (5-10)
· Click the Measuring button

The scanning module will make the specified number of measurements whose
results will be entered to the table (the Data tab). The first three columns will present
measured values of height (Sh), thickness (Sd), and flange slope (qR), while the other three
columns will present deviations of the measured values from the reference values (d_Sh,
d_Sd, d_qR).
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The Diagram tab is intended for displaying the diagram of values/deviations of the
measured profile from the selected reference. Deviation of the flange height and thickness
from the reference values must not be more than 0.1 mm. If deviations exceed the
permissible value, it is necessary to perform calibration of the scanning module.
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30.3.     Calibration

To carry out automatic calibration, do the following steps:
· Select the reference profile from the list 

· Perform the measurement (the Measuring button)
· Perform the calibration (the Auto calibration button)
· When scanning is complete, perform the testing procedure in accordance with

30.2. In case of positive result, save parameters:
oRight-click on the table and select Write
oRight-click on the table and select Write to FLASH
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30.4.     Restoring the factory settings

If parameters have incorrect values (negative or zero), it is necessary to restore the
factory settings by pressing the Load Default button. After that, recalibrate the profilometer.

Figure 1A
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31.     Annex 4. Software application for working with
the "A.U.R.A. Wheel" system

When working with the A.U.R.A. Wheel system from NEM Solutions, the laser
scanning module is controlled by the special software application installed on a tablet
computer.

31.1.     Installation

To install the software, select and run the Ikp5_Tablet.exe file. Follow the guidelines
in dialog boxes of the Installation Wizard. By default, the software will be installed in the
following directory – C:\Program Files (x86)\Riftek, LLC\Ikp5_Tablet\.

To start the program, press Start > All programs > Riftek, LLC > Ikp5_Tablet >
Ikp5_Tablet.exe. The main window is shown below:

31.2.     Settings

Before starting to work with the profilometer, it is necessary to configure
parameters.

Press the Settings button. The program will require a password. When initially
installed, the program accepts the following password: 1111. How to change the password,
see Par. 31.2.3.
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Enter the password and press Ok. The window of program settings will appear.

31.2.1.     Language

The user can change the language, form his own language support files as well as
change/edit the terminology used. To select the language, press Language, select the
language support file, and press Select.

How to create the language support file, see Par. 22.2.4.1.

31.2.2.     Gauge type selection

The program allows to work with the following gauges: IKP, IDK, IMR. When
selecting one of them, you will see a list of available devices (i.e. devices that have been
connected earlier).

Select the gauge and press the Select button. Parameters of the selected gauge
will be used to connect to it. If the device is not in the list, you can add it – press the Add
button and start to search for Bluetooth devices.
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Press Start and wait for the search to complete.

The detected devices with their serial numbers will appear:
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Select the device and press Pair gauge to include it in the list. Windows will report
an attempt to add a new device, and request a pairing code. 

If the pairing code is correct and the device is successfully added, the system will
display a message. The device installation may take some time. The pairing code for each
device consists of 4 symbols and is formed according to a serial number. For example, if a
serial number is 04217, then a code will be 0427; if a serial number is 01317, then a code
will be 0137, etc.

Select the device by pressing the Select button.
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If you do not use the device anymore, you can delete it by pressing the Delete
button. Similarly, you can add other gauges (IDK and IMR).

31.2.3.     Password

To change the password, press Password.

Enter a new password, confirm it, and press Save.
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31.2.4.     Calculation methods

Press Calculation method. On the screen:

To save the changes, press Save.

31.2.5.     Selection of displayed parameters

Press Displayed parameters. On the screen:

In order to select/deselect a parameter, set ON/OFF in the Show/Hide column. To
save the changes, press Save.
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31.2.6.     L-parameters

Press L parameters. The table displays only those L-parameters that are
necessary to calculate the selected geometrical parameters of the wheel. 

To save the changes, press Save.

31.2.6.1.     Preset values

L-
parameter

Default value Assignment

L1 2 mm Used for calculation of the flange slope (qR) 

L2 70 mm Defines position of the wheel rolling circle, and used for calculation:
- flange height (sH)
- flange thickness (sD)
- flange slope (qR)
- inclination angle (A)
- wheel diameter (D)
- rim thickness (T)
- wear (Wt, Wf, Wr)

L3 13 mm Used for calculation:
- flange thickness (sD)
- flange slope (qR)
- wear (Wf)

L4 13 mm An additional point for calculation of the flange slope (qR)

L5 10 mm Used for calculation of an angular wear (Wr)

L6 70 mm Used for calculation of slope of the rolling surface section (S1)

L7 105 mm Used for calculation of slope of the rolling surface section (S2)

L8 10 mm Used for measurement of the profile inclination angle at the required
point (A)

L9 140 mm Used for inverting the measurement direction (L9 – profile width)

L10 599,35 mm Used for calculation of the profile diameter (D)

L11 767 mm Used for calculation of the reference profile rim thickness (T)

L15 13 mm Used for calculation of the flange thickness of tram wheels (sD15)



IKP-5 Series, Model 2017 Year [Revision 1.1.0] 10.11.2017

Laser Wheel Profilometer. IKP-5 Series, Model 2017 Year

85

P7_1 
P7_2
P8_1
P8_2

50 mm
105 mm
110 mm
130 mm

Used for calculation of the hollow (Hl)

D1 
D2

70 mm
107,5 mm

Used for calculation of the hollow (Hl)

31.2.7.     Reference profile selection and installation

The program allows to compare the scanned profile of the wheel with the reference
profile. To select the reference profile, press Reference.

To delete the reference file, activate the line and press Delete.
To add the reference file, press Import and select the *.ref file.

31.2.7.1.     Writing the reference profile to the database

Reference profiles are stored in the database as profile description files with the
.ref extension. The software is supplied with several preset profiles. 

If there is no required reference profile in the database, the user can request the
missing profile from RIFTEK (free service).

31.2.8.     Measurement scheme

The measurement scheme is meant as a sequence of making
measurements/processing of wheels in the rolling stock with specified parameters of each
wheelset (wheelset numbers, car numbers, series, etc.). The program automatically offers
the operator to perform measurement of the wheel in accordance with selected scheme of
wheel processing. The program contains several preset schemes. Besides, the user can
form his own measurement scheme.
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31.2.8.1.     Selection or removal of the measurement scheme

To select the measurement scheme file, press Scheme.

Arrows in the figure show the direction of processing of wheelsets as well as the
names assigned to wheels.

To delete the scheme file, activate the line and press Delete. If you delete the
current scheme, the error message will appear.

To add the scheme file, press Import and select the *.sch file.

31.2.8.2.     Formation of a new measurement scheme

To form a new measurement scheme, press Add. The following window will appear:

Next:
· enter the scheme name;
· select the number of cars;
· select the number of axles;
· select the wheel processing scheme out of the options suggested;
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· press Ok.
This method of the measurement scheme formation allows to create only simple

schemes without specifying the wheelset numbers, car numbers, series, etc. To form a
complete scheme, see par. 29.

31.2.9.     Tolerances

The program automatically controls measured geometric parameters for going out
beyond the tolerances set. It is possible for the user to create groups of tolerances. Control
of parameters will be performed for a selected group. 

To select a current group of tolerances, press Tolerance. The table will show
tolerances only for the selected geometric parameters of the wheel.

A red color indicates the maximum/minimum critical values of parameters. An
orange color indicates the maximum/minimum values, which are close to critical values.

To delete the tolerance, activate the line and press Delete.
To edit the tolerance, activate the line and press Edit.
To add a new tolerance, activate the line and press Add. On the screen:
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Enter the tolerance name into the Name of tolerance field and the values into the
Min/War.Min/War.Max/Max fields. To save the changes, press Save.

31.2.10.     Vehicles

To view a list of rolling stocks, press Vehicle. The listed rolling stocks can be
selected for measurement.

Parameters of the rolling stocks:

Vehicle name Name of the rolling stock

Vehicle Id Identification number of the rolling stock

Vehicle description Description of the rolling stock

Schedule Schedule for the rolling stock

Send to AURA
Select "Yes" if you want to send data to the AURA database, or select "No" if you
don't

Scheme Measurement scheme name

# axles Number of axles

# wheels Number of wheels

Reference Reference name from a list of references (Reference tab)

Tolerance Tolerance name from a list of tolerances (Tolerance tab)

To delete the rolling stock, activate the line and press Delete.
To edit the rolling stock, activate the line and press Edit.
To add a new rolling stock, activate the line and press Add.

31.3.     Measurements

There are three types of measurements:
1. Single Measurement – measurement without specifying the rolling stock type,

measurement scheme, tolerances. Measurement results can be saved to the
WMC format.

2. Simple Measurement – measurement of the selected rolling stock with
specifying the scheme and tolerances. Measurement results are saved to the
WMC format.
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3. Automated Measurement – measurement of the selected rolling stock with
specifying the scheme and tolerances. Measurement results are transferred to
the AURA database.

31.3.1.     Single measurement

To enter the mode, press the Single Measurement button.

First, you need to establish the Bluetooth connection to the gauge: IKP, IDK or IMR.

The list contains devices selected in settings (see Par. 31.2.2. "Gauge type
selection"). After selecting, press the Connect button.

The Measurement button and the charging indicators will be active.
· Press the Measurement button.
· After pressing the Measurement button, the laser module starts scanning of the

wheel surface. During the scanning process (1-2 seconds), a red LED is lit.
· When the scanning process is complete, the program displays the measurement

results.
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Measurement results and profile coordinates can be saved to the file of the WMC
format. The files are saved to the following directory:

С:\Riftek,LLC\Ikp5_Tablet\Measurements\Losse metingen\

The IDK is designed to measure the wheel diameter. The IMR is designed to
measure the back-to-back distance. In order to change the gauge type, press the
Disconnect button, select the gauge you need, and press Connect.

The measurement procedure is similar to IKP.

31.3.2.     Simple measurement

To enter the mode, press the Simple Measurement button. This mode allows to
perform measurements in accordance with the rolling stock parameters (scheme,
tolerances, reference).

First, you need to select the rolling stock in the Select Vehicle window. The list
contains only those rolling stocks, the measurement results of which will not be sent to the
AURA database (the Send to AURA column is empty).
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Select the rolling stock (or specify its name in the search line) and press OK.
The program will show the measurement scheme and parameters for the selected

rolling stock.

Next, select and connect the gauge: IKP, IDK or IMR. The connection procedure is
described in the previous paragraph.

When the connection is established, the Measurement button will be active and
you can start measurements.
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Designations and buttons:

an ordinal number of the car to be measured (number of cars in the rolling stock)

pass to the previous/next wheel

pass to the previous/next car

a measured wheel

a wheel to be measured the next time

a non-measured wheel 

parameters of the measured wheel are beyond the tolerances

parameters of the measured wheel are close to the tolerances

measurement

31.3.2.1.     Measurement

· Press the Measurement button in order to measure the wheel offered by the
program (highlighted in green). The laser module will scan the wheel surface. 

· Upon completion of the scanning process, the program will show the values of
selected geometrical parameters.  
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When the value is beyond the tolerances, it will be highlighted in red:

The program allows to display only parameters of the measured profile. To hide the
reference values, you need to disable the Show Reference option (select "Off").

· To repeat the measurement, press the Measurement button.
· When a satisfactory result is obtained, press the Save button to save it.
· The program will offer to pass to the measurement of the next wheel in

accordance with the selected scheme of measurement.
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· To view the results of previous measurements, you can use the arrows. If you
select the measured wheel, the program will display the saved wheel parameters.

· When you measure the wheel that was already measured, the program prompts
you to replace the existing values with the new ones.

The measurement results can be saved in the WMC fromat. Each measurement is
saved in a separate file. The path:

С:\Riftek LLC\Ikp5_Tablet\Measurements\WMC\HM780_20170830\
Where HM780_20170830 is the directory name, HM780 is the rolling stock name,

20170830 is the date of measurement (yyyymmdd).
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31.3.2.2.     Measuring by IDK, IMR

To measure the wheel diameter and back-to-back distance, disconnect from IKP by
pressing the Disconnect button, and select the gauge you need: IDK (to measure the
wheel diameter), or IMR (to measure the back-to-back distance).

The measurement process is similar to IKP.
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The measurement results can be saved in the WMC format. Each measurement is
saved in a separate file.

31.3.3.     Automated measurement

The Automated Measurement mode as well as the Simple Measurement mode
allows to perform measurements in accordance with the rolling stock parameters (scheme,
tolerances, reference).

The only difference is that the list contains only those rolling stocks, the
measurement results of which will be imported to the AURA database (the Send to AURA
column is ticked).

Attention! The Internet connection is required in order to connect to the AURA database and to
transmit data.

The measurement procedure has one difference from the Simple Measurement
mode. In order to import data to the AURA database, it is necessary to measure all cars of
the selected rolling stock according to the measurement scheme. Only in this case the
Send to AURA button will be active.
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After pressing the Send to AURA button, the data transmission window appears. In
case of successful identification in the AURA system, the data transmission starts.

When the data is successfully transferred, the following message appears:
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If any error occurs while connecting to the AURA system (for example, if there is no
Internet connection), the error message appears.

In this case, you need to check the Internet connection and try to transmit data again
by pressing the Try Again button. 

To avoid the data loss, all measurement results are also copied to the directory:
С:\Riftek LLC\Ikp5_Tablet\Measurements\ AURA\4002_20170830\
Where 4002_20170830 is the directory name, 4002 is the rolling stock name,

20170830 is the date of measurement (yyyymmdd).

32.     Warranty policy
Warranty assurance for the Laser Profilometer – 24 months from the date of putting

in operation; warranty shelf-life – 12 months.

33.     List of changes

Date Revision Description

17.05.2017 1.0.0 Starting document.

10.11.2017 1.1.0 Added section 31 'Software application for working with the A.U.R.A. Wheel
system'.
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